Legal notices

Control4 Disclaimer
Control4® makes no representations or warranties with respect to this publication, and specifically disclaims any express or implied warranties of merchantability or fitness for any particular purpose. Control4 reserves the right to make changes to any and all parts of this publication at any time, without any obligation to notify any person or entity of such changes.

Legal Notice

GNU

GNU GENERAL PUBLIC LICENSE TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION (Section 3.b.)
You may copy and distribute the Program (or a work based on it, under Section 2) in object code or executable form under the terms of Sections 1 and 2 above provided that you also do one of the following:
Accompany it with a written offer, valid for at least three years, to give any third party, for a charge no more than your cost of physically performing source distribution, a complete machine-readable copy of the corresponding source code, to be distributed under the terms of Sections 1 and 2 on a medium customarily used for software interchange.
The complete text for this license is available on the Control4 web site at: www.control4.com.

Gracenote
Gracenote®, Gracenote logo and logotype, and the “Powered by Gracenote” logo are either a registered trademark or a trademark of Gracenote, Inc. in the United States and/or other countries.
Music and DVD recognition technology and related data are provided by Gracenote®.
Gracenote is the industry standard in Music and DVD recognition technology and related content delivery. For more information, visit www.gracenote.com.

MPEG
Fraunhofer IIS and Thomson. MPEG Layer-3 audio coding technology licensed from Fraunhofer IIS and Thomson. Supply of this product does not convey a license nor imply any right to distribute content created with this product in revenue-generating broadcast systems (terrestrial, satellite, cable, and/or other distribution channels), streaming applications (via Internet, intranets, and/or other networks), other content distribution systems (pay-audio or audio-on-demand applications, and the like) or on physical media (compact discs, digital versatile discs, semiconductor chips, hard drives, memory cards, and the like). An independent license for such use is required. For details, visit mp3licensing.com. Radio Locator is the service provider of AM/FM channel list.

Spread
This product uses software developed by Spread Concepts LLC for use in the Spread toolkit. For more information about Spread see www.spread.org.

Copyright and Trademarks
Copyright ©2016, Control4 Corporation. All rights reserved. Control4, the Control4 logo, the 4-ball logo, 4Store, 4Sight, Control4 My Home, and Everyday Easy are registered trademarks or trademarks of Control4 Corporation in the United States and/or other countries. All other names and brands may be claimed as the property of their respective owners. All specifications subject to change without notice.
No part of this publication may be reproduced, photocopied, stored on a retrieval system, or transmitted without the express written consent of the publisher.

Contact Information
Control4 Corporation
11734 S. Election Road
Salt Lake City, UT 84020 USA
www.control4.com
Part Number 200-00171-S
Composer Media Edition User Guide (OS 2.9.0, 09/14/2016 DH)
Contents

Legal notices .................................................................................................................2
Contents .........................................................................................................................3
Introduction ..................................................................................................................5
  Purpose .......................................................................................................................5
  Related documents and resources .............................................................................5
Getting started ..............................................................................................................5
  Requirements ............................................................................................................6
  Installing Composer ME .............................................................................................6
  Starting Composer ME ...............................................................................................7
Menu options ................................................................................................................9
  File .............................................................................................................................9
  Media .........................................................................................................................10
  Help ..........................................................................................................................10
  Refreshing the Navigators .........................................................................................10
  Closing Composer ME ..............................................................................................11
Using Composer ME to manage your media and playlists ..................................11
  Media view ................................................................................................................11
  Media Scanning Options ............................................................................................12
  Stored media .............................................................................................................12
  Broadcast media .......................................................................................................12
  Playlists .....................................................................................................................12
Adding digital media files to your Control4 system .................................................... 13
Setting up media on a CD or disc changer ........................................................................ 14
Auto-scan media in Composer ME ...................................................................................... 19
Testing the media connection ............................................................................................ 20
Setting up broadcast media for TV channels ................................................................. 20
Setting up media for radio stations ................................................................................. 22
Setting up playlists ............................................................................................................. 23

Other Composer ME tasks ............................................................................................... 24
  Clearing a media list .......................................................................................................... 24
  Exporting a media list ....................................................................................................... 24
  Importing a media list ....................................................................................................... 25
  Updating Composer ME .................................................................................................... 25

Glossary ............................................................................................................................ 26
Index ................................................................................................................................. 29
Introduction

Use Composer Media Edition (Composer ME) to set up your media and playlists and perform other tasks related to your music, movies, and videos.

The Composer ME interface lets you:

- Scan for your media and add its media information to the media database in your project.
- Create playlists of MP3, MP4, AAC, FLAC, or WMA files found through scanning.
- Add your favorite channels and stations to the Channels and Stations interfaces.
- Add photos for the custom screensaver on your touch screens and on-screen Navigators.

Purpose

The purpose of this document is to give you instructions, examples, and tips about how to add and manage the media for your Control4 system. This document applies to the Control4 Operating System 2.9.0 (OS 2.9.0).

Related documents and resources

<table>
<thead>
<tr>
<th>Document Title</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control4 System User Guide</td>
<td>PDF: ctrl4.co/userguide</td>
</tr>
<tr>
<td>Control4 Composer Home Edition Getting Started</td>
<td>Help: Composer HE application PDF: ctrl4.co/he-gs</td>
</tr>
</tbody>
</table>

Getting started

Use Composer ME to add and scan media, edit media information, and create playlists for your Control4 system. After you add your media to your Control4 system, you can browse and select your media, channels, stations, or playlists from any of your Control4 Navigators.

Composer ME requires a connection to the Control4 controller running Director. The brain of the Control4 system is the Control4 controller (for example, EA-3). The controller communicates with Control4 and third-party products to enable home automation and interaction with Control4-controlled devices.
Notes: (1) The term “controller” referenced in this document refers to any Control4 product that contains the Director component; for example, an EA-3 controller. Director is the software that controls the system.

Requirements

Composer ME requires that your system is functioning correctly before attempting to use this software. Talk to your Control4 dealer if this product does not function as documented; this may indicate that the Control4 system may not be set up properly.

Computer software and hardware

- Microsoft.NET 4 (the Composer install is launched automatically from the Control4 website).
- Microsoft operating systems supported (Windows 10, 8, 7, or Vista). Mac support when used with a Windows virtual machine such as Parallels or VMWare Fusion for Mac.
- 500 MHz or higher processor
- 256 MB RAM
- 90 MB available hard disk space
- Video card and monitor supporting a resolution of 1024x768 or higher
- Keyboard
- Mouse

Home computer network

- Wireless access point (WAP) or wireless router that supports 802.11 b/g/n (optional)
- TCP/IP-based (Ethernet) home network. This usually includes a network gateway, router or switch.
- A broadband Internet connection. During initial setup, a broadband Internet connection is required to update the Control4 system and retrieve media cover art. Also, a broadband Internet connection is required to support remote access to the system.

Control4 home automation network

- A Control4 controller (for example, an EA-3 controller).
- Control4 Composer Media Edition (Composer ME) software, version 2.9.0.
- Registration at customer.control4.com is required. See your dealer or the Control4 System Quick Start Guide for details.

Installing Composer ME

Follow the steps below to install the Composer ME software.

Prerequisites

Ensure that you understand the software and network requirements to use this product. Your dealer or installer can assist you if needed.
To install Composer ME:

1. Log in to your account at customer.control4.com and go to My Software > Downloads. Click the **Download Composer Media Edition** button to download the install file.

2. Double-click or open the install file to start the install process. You can also choose to download an older version of Composer ME to match your Control4 system OS version.

3. Follow the on-screen instructions to finish the installation process.

The Composer ME software download button will default to the latest version. We recommend you download the version of Composer ME software that matches your Control4 system OS version.

Starting Composer ME

When you start Composer ME, you must connect to Director on your home network.

**Prerequisites**

Ensure that you have installed Composer ME and your Control4 system has been registered to your customer.control4.com.

**To start Composer ME:**

1. From the desktop, double-click the **Composer ME** icon.

2. At the Composer ME startup screen, click **Local System**.
3 From the Directors dialog, select the Director’s IP address of the controller you are connecting to.

<table>
<thead>
<tr>
<th>Name</th>
<th>Address</th>
<th>Connect</th>
<th>Cancel</th>
<th>Add</th>
<th>Remove</th>
<th>Refresh</th>
</tr>
</thead>
<tbody>
<tr>
<td>Steph</td>
<td>home-controller-1000</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>virus-test-controller-1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>home-controller-1000</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>sharon_home-control</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>home-controller-1000</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>home-controller-1000</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>BRoss_Suite_System</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>WSPQA-BETA-132-C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>WSPQA-BETA-163-C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>WSPQA-PROD-210</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>home_controller-1000</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Tip: If the Director’s IP address does not appear immediately, click Refresh. If it still does not appear, contact your dealer.

Directors Dialog buttons:

- **Connect**—Connect to the Director on your controller.
- **Cancel**—Cancel and close the Director dialog.
- **Add**—Launch a dialog that lets you add the Director’s address of the controller to which you are trying to connect.
- **Remove**—Lets you remove a Director.
- **Refresh**—Update the Director list to display the recently added Directors.

4 Click Connect. Composer ME opens to the main Composer ME screen.
Menu options

Composer ME menu options:

- **File menu**—Connect to the Director on your home network, refresh Navigator devices with new media information, or exit Composer ME.
- **Media menu**—Create a new playlist, or clear, export, and import media lists. See “Media Menu” below.
- **Help menu**—View the Composer ME online help and software version.

File

The File menu lets you perform project file management tasks, connect to Director, and refresh Composer ME and the Navigators, including touch screens, Control4 apps (if they are online), and on-screen Navigators. The file management options relate to the Composer ME project files you back up on your PC (they have a .c4p extension). Project files always save by default to the 'My Documents' folder.

When you set up a Control4 system, you create live project configuration information on the controller that is backed up to a project file on your PC. This lists specific information about each system, including devices, connections, configuration, programming information, and media.

- **Connect to Director**—Connects you to the Director residing on the controller. When you connect, project configuration information from the controller is displayed on the Composer ME screen.
- **Disconnect from Director**—Disconnects you from the Director. Composer ME prompts you to back up your project before disconnecting you from the currently-connected Director. This option is available when connected to the Director.
- **Refresh**—Refreshes the Composer ME screen with the current information from Director.
- **Refresh Navigators**—Refreshes the Navigators with the latest information from Director. **Note:** Control4 for PCs and tablets must be updated in that app. Control4 for iPhone, iPod touch, iPad, and Android devices will update if online.
- **Exit**—Exits Composer. Composer ME prompts you to back up your project prior to exiting the software and returning to the desktop. Control4 recommends that you always back up your project before you exit.
Media

From the Media menu, the media either has been scanned or manually added to the media database. After an item is added to the media database, the cover art and metadata about the media is viewable and selectable from any of the Navigators.

**Tip:** Control4 recommends that you use the Export Media List (see below) feature which lists of all your media saved to the hard drive on your PC.

The following options are available:

- **Clear Media List**—Clears the media list associated with the highlighted device from the media database.
- **Export Media List**—Exports a media list for the selected device from your controller to your PC.
- **Import Media List**—Imports a media list from your PC to your controller.
- **Export Playlists**—Exports a playlist from your controller to your PC.
- **Import Playlists**—Imports a playlist from your PC to your controller.
- **Import DVD List from File**—Imports a Microsoft Excel list of DVD titles for a disc changer.
- **New Playlist**—Creates a playlist of MP3, WMA, MP4, AAC, or FLAC files. The playlist is available from any touch screen or on-screen Navigator. Add albums, remove songs, re-order songs, etc. **Note:** If you remove songs from a playlist, it does not remove them from the media database.
- **Delete Playlist**—Removes a playlist.
- **Rename Playlist**— Renames a playlist.
- **Tag media files**—Used for OS 2.0 conversion of media files so all media players can see the same tags.

Help

From the Help menu, you can access the online help of this Composer ME User Guide with Index, Glossary, and Search options, or check the version of your Composer ME software and Director component.

Refreshing the Navigators

Use the Control4 Composer ME menu bar to refresh your touch screens, on-screen Navigators, Control4 apps, and System Remote Control whenever you make changes to Composer ME.

**Prerequisites**

- Ensure that the Navigators are added and identified to the Control4 system. Your dealer can help you.

**To refresh the Navigators:**

1. In case your Navigators do not automatically refresh after you've made changes to Composer ME, from the menu bar, click **File**, then click **Refresh Navigators**.

**Tip:** New media shows up automatically in the Navigators unless your device is disconnected or has changed locations. In this case, you may need to identify the device again.
Refer to the Control4 System User Guide to test your Navigator features.

Closing Composer ME

Click File > Exit to close the application.

Before Composer ME exits, you are prompted to back up your project. It’s always good practice to do so.

Using Composer ME to manage your media and playlists

Media view

The Media view is the primary screen in Composer ME. From this view you can see the media in your project, add or scan your media, manage changes to your media, and manage playlists.

Media view (same view as the main screen after startup):

There are four main categories listed in the Media window (left pane):

- Media Scanning Options
- Stored media
- Broadcast media
- Playlists
Media Scanning Options

Media Scanning Options lets you view the storage space status for your media information and configure media scanning options.

Stored media

Stored media refers to media physically or digitally stored in the Control4 system.

Media types supported:

- **CD and DVD discs, or Disc Changers**—Store DVD and CD disc information including high-resolution Cover Art, Title, Artist(s), Genre, and more.
- **Digital media**—Store digital audio (AIFF, FLAC, MP3, M4A, OGG, WAV, and WMA file types) and digital video (AVI, DVD, DIVX, ISO, MKV, MPG, MP4, MOV, and WMV file types) media information including high-resolution Cover Art, Title, Artist(s), Genre, and more. Digital media files can be stored on USB or eSATA drives attached to a controller, or on a network file storage location.

Broadcast media

Broadcast media refers to radio stations (AM/FM and XM/Sirius) and TV stations (over the air, satellite and cable).

Media types supported:

- **Satellite TV**—Store satellite TV (DirecTV, Dish, and others) channel information including high-resolution channel logo, channel number, description, and genre.
- **Cable TV**—Store cable TV channel information including high-resolution channel logo, channel number, description, and genre.
- **UHF/VHF**—Store UHF/VHF (over-the-air TV) channel information including high-resolution channel logo, channel number, description, and genre.
- **AM/FM/XM**—Store AM, FM, and XM radio station information including high-resolution station logo, station number, description, and genre.

Playlists

With Composer ME you can create and manage playlists created from your digital media files. See Setting up playlists in this document.
Adding digital media files to your Control4 system

Before you can view and select your media from the Control4 Navigators, your media must be added into your system. Composer ME can assist you in adding digital media files to a desired storage location, on a Network File Storage or USB/eSATA drive connected to your controller. Your Control4 system can scan the media files to import existing metadata, if present in the media files, and perform an online search to find relevant media information. So you first need to add and scan your media using the Composer ME Media view.

![Composer ME Media view](image)

Prerequisites

Before you can add digital media files to a storage location, the storage location must be configured and accessible to your Control4 system. Ensure that the appropriate devices have been added to your Control4 system and are connected to the network or the controller. Contact your dealer or installer for details.

To add and scan digital audio media files:

1. In the Media list on the left, select the storage location. If the storage device is a Network File Storage, select **Audio Media**.
2. In the right pane, click **Add**.
   **Tip:** If you get a dialog box that states you cannot add media, contact your dealer or installer to configure the storage location.
3. Browse to the folder that contains the files that you want to add. Select the folder and click **OK**.

Composer ME will copy the media files to the storage location. After the files have been added, the scan automatically starts. In a few moments, the media is scanned and you will see a list of albums appear. You might see the on-screen Navigator update during this process also.
Tip: Another way to add files to a network share is to go to the Windows Start menu, and select Run. Type `\<network share’s IP Address>`\, press Enter, navigate to the desired folder, and copy the files. After copying files directly to your storage location, you need to start a scan manually. See “Auto-scan media in Composer ME”

5 Refresh your Navigators.

6 The media is now selectable for viewing from the touch screens, Control4 apps, on-screen Navigators, and System Remote Control.

To add and scan digital video media files:

1 You must add digital video media files to your storage location manually. You can copy them to your eSATA drive, if connected to your computer, or copy them to your network storage location. To add files to a network share, go to the Windows Start menu, and select Run. Type `\<network share’s IP Address>`\, press Enter, navigate to the desired folder, and copy the files.

2 In the Media list on the left, select the storage location, and select Video Media.

3 In the right pane, click Scan. See “Scanning media in Composer ME” for more details.

Composer ME will scan the digital video files from the selected storage location. In a few moments, the media is scanned and you will see a list of videos appear. You might see the on-screen Navigator update during this process also.

Tip: To play back digital video files, a media player capable of playing those files and communicating with your Control4 system must be added to the project. Contact your dealer for more information.

4 Refresh your Navigators.

5 The media is now selectable for viewing from the touch screens, Control4 apps, on-screen Navigators, and System Remote Control.

Setting up media on a CD or disc changer

When setting up a disc changer (or CD changer), you can add and scan media according to the controls available on your disc changer. Adding and scanning populates the media information to the media database, which lets you view the media from your touch screens, on-screen Navigators, Control4 apps, and System Remote Control.

In the Media pane, if you select CD or Disc Changer, the following options are available. In some cases, you select an entry and click a button, or just click one of these buttons (Search and Scan):

- **Edit.** Edit an entry’s metadata (Title, Artist, Director, Genre, etc.).
- **New DVD.** Add new DVD information to the media database.
- **New CD.** Add new CD information to the media database.
- **Delete.** Delete an existing entry.
- **Scan.** Scan the media on your CD or disc changer to import the information to the media database (recommended if available).
- **Search.** Search for media titles on your CD or disc changer in the media database.
The following steps show how to add media to the media database using these options.

Prerequisites

Ensure that the CD or disc changer has been added and identified in the Control4 system. Your dealer or installer can do this for you.

To scan media on a CD changer to the media database:

1. Select the CD Changer in the Media pane.
2. In the Disc Changer pane (right pane), click Scan.
3. The scan results appear in the Discs pane. After you refresh your Navigators, you are ready to play music.

To search media on a Disc Changer to add to the media database:

1. In the Disc Changer pane, click Search. The search dialog appears.
2. Type the DVD name in the blank box. For example, type ‘A Beautiful Mind,’ and then click Search. The ‘DVD Title’ matches appear in the Search Results window.
3. Use the scrollbar if necessary to find the appropriate DVD title.
4. Select the DVD title, drag it directly over the empty line item in the disc changer list, and then select it.
5. Click Finished.
6. Repeat the previous steps for the DVDs/CDs in the disc changer that you want to add to the media database.
7. Refresh your Navigators. The media you added is now available to view in the Navigators.
To add and search using the New DVD or New CD options:

1. Select CD or Disc Changer in the Media pane.
2. Select an ‘empty’ line item for the New DVD and New CD buttons to appear.
3. Click either New DVD or New CD as appropriate.
4. The New Movie or New Album dialog appears. In the Title box, enter the DVD you want to play, for example: ‘A Beautiful Mind.’
5. Click Search.

New DVD:
The following results appear:

Select an entry to get detailed results:
New CD:

Similar results occur as with the New DVD option. Follow the same steps.

6 When the Search dialog appears, use the scrollbar if necessary to find the appropriate cover art, and highlight it.

You can change the search criteria, and search again if necessary. The possible matches from the web database appear in the Search Results window (see above).

7 Click Next. You can choose which information to import, and edit any associated information before adding the media to the media database (see screen above).

8 Click Finished.

9 Click OK.

10 Refresh your Navigators. The DVD is available to view in the CD or DVD pane and on the touch screens, Control4 apps, and on-screen Navigators.

To edit CD information:

1 In the Media view, double-click the device on which you want to edit a CD, for example, a CD changer, disc changer, controller, or digital audio.

2 Click the Edit button, or double-click the media under <Media> Title.

3 To edit and enter any changes, click the Album tab (for music), for example. Edit the information in the boxes under Name, Artist, Label, or Genre.
   - Click the Tracks and Notes tabs to view and edit Track Titles and Notes.
   - Click Find Art File or Remove Art to change the cover art.

4 When you are finished, click OK.

5 Click one of the Search buttons next to the Name to search the database for similar entries.

6 To select a search result, select the album Title and double-click, or click Next.

7 At the next screen, view and edit the album information, including Name, Artist/Composer, Label, Genre, Year, Art, and Notes.
8 Make your changes, and click **Finished**. To return to the previous screens, click **Back**.

**To edit DVD information:**

1 In the Media view, select the disc changer or DVD, and then select a movie.
2 Click the **Edit** button, or double-click the title under Discs.
3 Click the **Movie** tab. Edit the Title, Director, Studio, Genre, Run Time, Release date, and Rating as desired.
4 Click the **Cast** and **Synopsis** tab. Click in the **Cast** and **Synopsis** boxes to make the desired changes.
5 Click the **Movie** tab.
6 Click **Search** to search the database for other DVDs.
7 Double-click the desired DVD, and edit the information as desired according to the previous steps.
8 When you are finished, click **Finished**.

**Auto-scan media in Composer ME**

**Notes:**

- If you scan a DVD or CD, and the media is not recognized, it will be titled “unknown.” You can edit the DVD or CD’s metadata and manually provide this information from Composer ME.
- Because media scanning has been moved to the background, the scanning status is only available through Director status messages. To do this, you can either watch the Director status line or re-select the media to view the content that has been scanned.

**Prerequisites**

Ensure that the devices you want to scan have been added and identified in the Control4 system. Your dealer or installer can do this for you.

**To schedule a regular scan of media:**

1 From the Composer ME main screen, select **Media Scanning Options**. To scan your media now (and not set up a scheduled scan), click **Scan Now** and skip the Scanning Schedule in Step 2.
2 In the Options pane, set the schedule as follows:
   - **Scanning Schedule**—Select one:
     - **Never**—Select if you never want to schedule an automatic scan.
     - **Every x Days or Weeks** (up to 10)—Select the frequency to scan.
     - **On the following days**—Select Sunday through Saturday.
     - **At <time>**—Use the **up** and **down** arrows to select the time. Highlight AM or PM and type the value: AM or PM.
   - **Files To Scan**. Select a device and extension.
   - **Network File Storage**—Select if you have a NAS (network attached storage) device you want to scan.
   - **USB Drive**—The manufacturer’s USB drive appears here. Select if you have a USB drive you want to scan.
• **Extensions**—Use the *up* and *down* arrows to choose the file type to add or remove. To add a file extension (if it doesn't appear in the list), use the *down* arrow to select the extension, select *Video* or *Audio*, and then click *Add*. Click *Remove* to remove that file type from the list.
• **Use Online Media Lookup to improve scan results**—Check if you want the scan to access the Internet to search for missing metadata information (title, cover art, genre, tracks, or other information.). *Tip:* To update existing media with high-resolution cover art after updating your system to OS 2.8+, check this box and scan the media files.
• **Remove media from the database if the files no longer exist**—Check to remove database information when a media file has been deleted.
  Important: If you disconnect a USB drive with media on it and run a scan with this option selected, the media database entries will be deleted, and you may not want to delete them if you use the drive again.
• **Update media database if file tags have changed**—Check to have the database updated if the metadata changes.

3. Click *Apply*.
4. Click *Scan Now* to start the scan immediately or *Stop Scan* if you've started the scan and want to stop it.

### Testing the media connection

To test control of media through the Control4 Navigators (System Remote Control, on-screen Navigator, Control4 apps, or touch screens), use the steps outlined in the Control4 *System User Guide*.

Suggested test items:
• Play an album
• Add an album or track to the Now Playing queue
• Play a playlist created in Composer
• Create a playlist at a Navigator (for example, one of the touch screens)
• Play multiple streams of music (play different music in different rooms)
• Play a movie on the television, DVD player, or Blu-ray player

### Setting up broadcast media for TV channels

Use Composer ME Media view to set up TV, cable, or satellite channels for display in the Navigators.

**Prerequisites**

Ensure that your television and satellite or cable devices are added and identified in the Control4 system. Your dealer or installer can help you do that.

**To set up media for broadcast television channels:**

1. Highlight *UHF/VHF* or your satellite or cable TV broadcast media type.
2. Click *Search*.
3. When the dialog appears, type your *zip code* in the box.
4. Click *Search*, and use the pull-down menu to select *Local Broadcast Listings*. The available channels are populated according to the Search Results.
5. Check the boxes to select the desired channels that you want to appear on the touch screens, Control4 apps, on-screen Navigators, and System Remote Control.

6. Click OK.

The selected stations populate in the UHF/VHF pane. You can edit the information as needed; add a description, genre, etc.

7. (Optional) To edit a channel, select the channel, and click Edit. The following dialog appears.

8. Edit the information and click OK.
9 Refresh your Navigators. The media can now be selected to view in the Navigators.

Setting up media for radio stations

Use Composer ME Media view to set up radio station listings to display on the Navigators.

Prerequisites

- Ensure that your devices are added and identified in the Control4 system. Your dealer or installer can do that for you.
- Ensure that you have a tuner in the system.

To set up media for radio stations:

1 Under Broadcast, select the radio type: AM Radio or FM Radio.
2 Click Search.
3 When the dialog appears, type your ZIP Code in the box.
4 Click Search again. Use the pull-down menu to select AM Broadcast Stations or FM Broadcast Stations if applicable. The available stations are populated in the Search Results window.
5 Check the boxes to select the desired stations that you want to appear on the touch screens, on-screen Navigators, Control4 apps, and System Remote Control for that radio type.
6 Click OK.

The selected stations display in the AM or FM Radio pane.

7 (Optional) To edit a station, select the station, and then click Edit.
8 Edit the information, and then click OK.
9 Refresh your Navigators.

10 Repeat Steps 1-5 for each radio broadcast (AM or FM) you want to set up. Set up each one separately. The media is now ready to view in the Navigators for selection.

Setting up playlists

Use Composer ME Media view to set up a playlist to play songs and albums from your touch screens, Control4 apps, On-Screen Navigators, and System Remote Control.

Prerequisites

Ensure that the appropriate audio devices are added and identified on the Control4 system. Ensure that you have scanned your media. Your dealer or installer can help you do this.

*Note: Playlists are limited to 500 songs total.*

To create a playlist:

1 From the Media menu, select **New Playlist**.

2 A ‘New’ playlist appears. You can rename it now, or later you can right-click and select **Rename Playlist** to change the name. **Example:** Change **New** to **Frank’s Playlist**.

3 Select your storage location, find the desired albums or tracks, and drag the songs to the playlist. Songs or albums will be ordered in the playlist in the order they are added.

4 Create and play songs from your playlists using your touch screens, Control4 apps, or on-screen Navigators. See Control4 **System User Guide** for details.
To delete albums or songs from the playlist:

1. After you add the albums, select the playlist that contains the songs to delete.
2. Right-click on the songs you don’t want in your playlist, and select **Delete**.

   **Tip:** To remove multiple songs, press **Shift**, select the songs, and then right-click **Delete**.

---

### Other Composer ME tasks

Use Composer ME to perform other media-related tasks (see the sections below).

- “Clearing a Media List”
- “Exporting a Media List”
- “Importing a Media List”
- “Updating Composer ME”

---

### Clearing a media list

Use Composer ME Media menu to remove media information about albums and songs from the media database.

**Prerequisites**

Ensure that media has been added and identified to the Control4 system. Your dealer or installer can help you do that.

**To clear a media list:**

1. Select the storage location on which you want to clear the media information.  
   **Example:** USB drive.
2. From the Media menu, select **Clear Media List**. This removes the information including the title, cover art, and related information from the media database.

   **Note:** This option does not remove the media files.

---

### Exporting a media list

Use Composer ME Media menu to export a media list from your media database to your PC.

**Prerequisites**

Ensure that the device to export to and the media have been added and identified in the Control4 system. Your dealer or installer can help you do that.

**To export the media list:**

1. Select the **storage location** from which you want to export the media list.  
   **Example:** USB drive.
2. From the Media menu, select **Export Media List**.
This saves a copy of the file that contains all the title art and information from the media database to your PC.

**IMPORTANT!** This option does *not* move the media files.

### Importing a media list

Use Composer ME Media menu to import a media list from your PC to your media database.

**Prerequisites**
Ensure that the device to import to and the media have been added and identified to the Control4 system. Your dealer or installer can help you with that.

**To import the media list from your PC to the media database:**

1. Select the **device** on which you want to import the media list. **Example:** USB drive.
2. From the Media menu, select **Import Media List**.

This saves a copy of the file that contains all the title art and information from your PC to your controller’s media database.

**IMPORTANT!** This option does *not* move the media files.

### Updating Composer ME

Composer ME should always be updated to match the Control4 system version. If your dealer has updated your Control4 system, you can update Composer ME by downloading the new version.

**To update Composer ME:**

1. Log in to your account at customer.control4.com and go to My Software>Downloads.
2. Click on **Download Composer Media Edition** and select the Composer Media Edition version that matches your Control4 system.
3. Open the file after it has downloaded and follow the on-screen instructions to complete the installation.
## Glossary

**4Sight:** An Internet service that provides a connection to the home automation system any time and from any place worldwide.

**AAC:** Advanced Audio Coding. A successor to the MP3 format. A standard, lossy compression and encoding scheme for digital audio. Touts better sound quality.

**AV:** Audio Video

**CD:** (Compact Disc) — An optical disc that stores digital data. This format is compatible with Control4 products.

**Composer:** The Control4 software used to design and define a Control4 home automation system.

**Composer Pro:** Composer is used to set up and configure Control4 devices to communicate with each other in a home automation system.

**connection:** Devices that are bound or linked together in Composer so they can communicate with each other.

**contact:** Contacts are generally used to monitor the status of something (door, window, water sensor, etc.) and can be connected through a security panel or directly using a Control4 controller or Contact/Relay Extender. Contacts connected to a Control4 controller or Contact/Relay Extender can be configured either as NC (normally closed) or NO (normally open).

**Control4 system:** A home automation system designed and developed by Control4.

**controller:** The main device that makes home automation possible. There may be multiple controllers within a Control4 system. The controller that runs Director is referred to as the Primary controller.

**device:** A component that requires a device driver; code that is used to allow the Control4 system to work with that device.

**device driver:** Every device in the Control4 system needs a corresponding device driver to control the device.

**digital audio player:** Provides digital audio streaming capabilities from a controller with hard disk space for music and movies.

**DirectR:** Each Control4 controller (such as an EA-5) ships with pre-installed Director software (Linux based) embedded in the device. The Director communicates with Control4 products and third-party products to enable home automation and interaction of individual devices. Director runs the Control4 devices. Composer Pro is the software used to connect to and program a system Director that resides on a controller.

**DVD:** (Digital Versatile Disc) — A media format for video and data storage.

**Ethernet:** Uses Ethernet category 5 (CAT5 or CAT5e) wiring to transfer data. Ethernet uses a star network topology that allows multiple points to communicate to a single point. The Speaker Point devices and touch screens use Ethernet to communicate to the Control4 controller.

**file format:** A format used by applications to store/read files.

**FLAC:** Supported by Control4 since software release 1.8, this is a free, open source, lossless audio codec format that supports tagging, cover art and fast seeking. Audio is compressed with no loss in quality.

**home network:** A network installed in the customer’s home that provides an Ethernet or wireless connection so that Control4 devices can communicate with each other.

**home automation system:** The Control4 system: a line of home automation products that communicate with each other over Ethernet, WiFi, or ZigBee for a total home automation experience.

**LCD:** (Liquid Crystal Display) — A display used with some Control4 interfaces.

**LCD Navigator:** An LCD device used to control lighting, music, videos, etc., on an LCD screen.

**List Navigator:** Menu options that are visible on a System Remote Control.
media database: Media information is stored in the media database, which will permit users to view the media from the Navigators.

metadata: The information that describes the media: title, cover art, artist, song or movie, genre, etc.

MP3: A music format that makes streaming audio available.

MP4: An audio and video format. Can also store images and subtitles.

Navigator: A Control4 Navigator used with the Control4 system to control lights, music, videos, etc. Navigator is software that the customer interacts with using a universal remote control, On-Screen Navigator, Control4 apps, or touch screen.

network-attached storage (NAS): A hard drive or network share drive that can be attached to the Control4 system and used to retrieve and play music and movies in the system.

On-Screen Navigator: Allows you to select the controller (EA-1, EA-3, or EA-5) in the room that controls the source for the on-screen display.

playlist: A list of songs compiled in a list. The list can be compiled by songwriter, album, song type, or any combination of the above.

programming: A machine-readable artificial language used to express computations that can be performed by a device.

project tree: A tree view in Composer where the project is layered by the larger branches (Home, Office, etc.) and then the lower branches (floor, rooms, etc.), and finally to the leaf level (drivers).

Remote Director: Connects you to the home network while working in Composer from a remote location.

scan: An electronic read of media for replay on Control4 devices.

switch: An extension of a router that adds more Ethernet ports to support additional devices or clients on the local network.

System Remote Control: A Control4 System Remote Control is a universal solution that replaces remote control devices from other manufacturers, and includes programmable buttons. This System Remote Control can access on-screen (graphical) Navigators.

touch screen: A touch screen is a home automation system Navigator that controls the home’s lighting, music, videos, and other devices on the home automation system.

USB: (Universal Serial Bus)—A connector format used with USB drives that connect to a USB port on Control4 devices.

virtual connection: A term used in Composer Pro to indicate a connection outside the network.

Virtual Director: A connection to a virtual controller only (a PC is the Director host rather than the controller). Projects created or edited here are benign until the saved project is loaded onto a controller.

WiFi: Uses bi-directional wireless technology to transfer data. WiFi (wireless fidelity) devices “connect” to each other by transmitting and receiving signals on a specific frequency of the radio band using a wireless access point. This technology uses the star network topology. WiFi uses high bandwidth 802.11.

WMA: (Windows Media Audio)—Audio data compression technology developed at Microsoft; an audio file format that competes with MP3.

ZigBee: A wireless network that uses bi-directional wireless mesh network technology to transfer messages from one device to another. Unlike a star network topology where devices can only send messages to each other by sending them first to a single central device (which then delivers the message to the recipient device), a mesh network topology allows the devices to forward messages from one device to another, thereby extending the effective range of the network. Uses low bandwidth 802.15.4. 250 devices are allowed per controller but Control4 recommends 125.
ZigBee Pro: The 1.1 version of ZigBee that provides improvements in standardization by: allowing more interoperability with other Control4 devices, support for home automation profiles, and improving the scalability of multiple ZigBee access points.
Index

AAC, 5
Add Director, 8
Add new CD, 16
Add new DVD, 16
Album tab, 18
AM radio, add, 22
AM/FM, 12
Broadcast media, 12, 20
Cable TV, 12
CD, 12
  add new, 14, 18
  edit information, 18
CD changer
  scan media, 15
  set up media, 14
clear media list, 10
Composer
  close, 11
  refresh Navigators, 10
Composer ME
  interface, 8
  update, 25
Connect to Director, 8, 9
Contact information, 2
Copyright, 2
Cover art, find, 18
Create playlist, 23
Delete media, 14
Delete playlist, 10
Delete songs from playlist, 23
digital audio, 12
DirectTV, 12
Disc changer, 12
Disc Changer pane, 15
disc changer, set up media, 14
Disclaimer, 2
Disconnect from Director, 9
discs pane, 15
Dish Network, 12
DVD, 12
  add new, 14
  edit information, 19
DVD, add new, 16
Edit metadata, 14
Exit Composer, 9, 11
Export media list, 10
Export playlists, 10
File extension, add, 20
file menu, 9
File tags, 10
Find cover art, 18
FLAC, 5
FM radio stations, add, 22
GNU, 2
Gracenote, 2
hard disk space, 6
Help menu, 9
Home network requirements, 6
Import DVD list from file, 10
Import media list, 10
Import playlists, 10
Installation, 7
Internet connection, 6
Legal notice, 2
Local broadcast listings, 20
media database, scanning and
  adding to, 14
Media file tags, 10
Media list, clear, 24
Media list, export, 24
Media list, import, 25
Media menu, 9
Media pane, 14
Media scanning, status messages,
  19
Media view, 11
Media, remove, 20
Menu options, 9
Movie tab, 19
Movie, add new, 16
MP3, 5
MPEG, 2
Music, add new, 18
Network file storage, 12
Network requirements, 6
New playlist, 10
Playlist, create new, 23
Playlist, delete songs, 23
Purpose of document, 5
Refresh Composer ME, 10
Refresh Director list, 8
Refresh Navigators, 9
Refresh screen, 9
Related documents, 5
Remove media, 20
Rename playlist, 10
Requirements, 6
Scan media, 11, 14
Scan now, 20
Scanning
  Schedule, 19
USB drive, 19
Search dialog, 18
Search Results window, 18
Start Composer ME, 7
stop scan, 20
Stored media, 12
TCP/IP, 6
Test media, 20
UHF/VHF, 12, 20
UHF/VHF pane, 21
USB drive
  scan, 19
Video resolution, 6
WMA, 5
XM, 12